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Echtzeit-Produktvisualisierung & PBR

in Modo und

Marmoset

In diesem Artikel erstellen wir ein 3D-Modell, welches in Echtzeit gerendert wird. Dabei werden in den Workflow
State-of-the-Art-Videospieltechnologien und Konzepte mit einbezogen.

ei Produktvisualisierungen bietet
BEchtzeit einige Vorteile: Anderungen

sind sofort sichtbar, lange Render-
zeiten fallen weg und auf teure Spezial-
hardware kann verzichtet werden. In der
Vergangenheit waren zwar teure Hard- und
Softwarelésungen fur fotorealistisches Ren-
dern notwendig, aber dies ist spatestens seit
der EinfUhrung von Physically Based Rende-
ring (PBR) im Bereich der Videospielgrafik
nicht mehr der Fall.

Zum Hintergrund: FUr das Berechnen von
fotorealistischen Bildern werden im Compu-
ter Naturgesetze simuliert. FUr die korrekte
Darstellung von Licht, Schatten und Ober-
flschen sind komplexe mathematische und
physikalische Berechnungen notwendig.
Dies schlagt sich in langen Renderzeiten
nieder.

Aber Videospiele kénnen sich diese lan-
gen Berechnungszyklen nicht leisten. Eine
aus Einzelbildern zusammengesetzte Se-

quenz muss aus 30 bis 60 Einzelbildern
bestehen, um fUr das menschliche Auge
flussig zu wirken. Da die Software unmit-
telbar auf die Eingabe des Spielers reagie-
ren soll, kénnen die einzelnen Bilder nicht
vorher berechnet werden. FUr moderne
Spiele-Engines bedeutet dies, dass die Be-
rechnung eines einzelnen fotorealistischen
Bildes nicht I8nger als eine DreiBigstelsekun-
de beanspruchen darf. Um dieses Ziel zu er-
reichen, werden komplizierte physikalische
Formeln verkUrzt und visuelle Darstellungen
vereinfacht. Diese Ergebnisse sind durch das
Aufkommen von neuen Verfahren oft kaum
noch von zeitaufwendigen Offline Rende-
rings zu unterscheiden.

FUr die Produktvisualisierung ergibt sich
hieraus, neben Zeit- und Kostenersparnissen,
ein weiterer Vorteil: Objekte lassen sich
nicht nur als Standbild darstellen, sondern,
ohne Vorberechnungszeit, von allen Seiten
interaktiv betrachten.

von Patrick Mochel

Wahl der Software

FUr unser vorliegendes Projekt sind zwei Kri-
terien ausschlaggebend: Ein einfacher und
effizienter Workflow sowie die Einbindung
moderner Echtzeitrendertechniken. Zum
Modellieren verwenden wir Modo, welches
sich im Bereich der Visualisierung groBer
Beliebtheit erfreut und auch als Tool zur Er-
stellung von Game Assets bestens geeignet
ist. FUr die Texturierung kommt Photoshop
zum Einsatz. Da es sich bei PBR lediglich um
ein Konzept handelt, das die Gestaltung von
Oberfladchen bestimmt, wird keine zusatz-
liche Spezialsoftware benétigt.

FUr das Darstellen unseres Objektes
kommt Marmoset Toolbag 2 zum Einsatz
(siehe DP 15:07). Neben einer schnellen
Funktion zum Abspeichern von Standbil-
dern bietet es auch die Maglichkeit, frei
drehbare dreidimensionale Objekte unter
HTML5, ohne zusatzliche Plug-ins, einzu-
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binden. Ein Beispiel hierzu findet sich unter
www.patrick-moechel.net/dp.htm.

Erstellen der Geometrie in Modo

Einzelne Objektinstanzen werden in Modo
.Mesh" genannt. Hierbei handelt es sich zu-
nachst um einen leeren Container fur Geo-
metrie. Dieser kann beliebig gefuUllt werden,
etwa mit mehreren Primitives oder selbst
erstellter Geometrie.

Ein groBer Vorteil dieser Art der Szene-
organisation besteht darin, einzelne oder
mehrere Faces sowie ganze Koérper, ge-
nannt Items, zwischen den Containern per
Copy-and-paste hin- und herbewegen zu
kénnen. Dementsprechend leicht fallt es,
die Szene nach Baugruppen zu sortieren
(Canopy, Battery, Servo, Washplate, etc.;
siehe Abb. 1). Mehrere Mesh Container las-
sen sich zwecks der Ubersicht auch zu Grup-
pen zusammenfassen. Dieses Szenensetup
ermoglicht auch die schnelle Erstellung einer
Explosionszeichnung (siehe Abb. 2).

Den einzelnen Bauteilen weisen wir ver-
schiedene Farbwerte zu. Nun sortieren wir
jedoch nicht nach Baugruppen, sondern
nach Materialien. So kénnen einem Teil
mehrere Farben zugewiesen werden, wie in
Abb. 3 zu sehen. Da wir diese Farbinformati-
onen als sogenannte Color Map verwenden,
sollten sich die verschiedenen Farben mog-
lichst stark voneinander abheben. So féllt es
spater leichter, den Uberblick zu bewahren.
Zum Erstellen der Color Map nutzen wir ei-
nen ,Render Material to Texture" genann-
ten Prozess: Im Shading Tab: Add Layer >
Image Map > (new image); Rechtsklick auf
das neue Image: ,Bake to Texture".
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Abb.1: Jede Baugruppe erhalt ihren eigenen
Mesh Container.

Diese Technik bietet sich auch hervorra-
gend for das Erstellen von Decal-Masken
an. Komplexe Linienverldufe kénnen direkt
in die Geometrie geschnitten werden, um
so Farbfldchen per Edge Loops voneinander
zu differenzieren, wie in Abb. 4 zu sehen
ist. Die hieraus gewonnene Textur kann nun
als Grundlage zur Erstellung der Decals in
Photoshop verwendet werden. Bevor wir mit
dem Texturieren beginnen, exportieren wir
unser Mesh als .obj-Datei.

EinfGhrung in PBR

Wie am Anfang erwdhnt, handelt es sich bei
PBR um eine Rendermethode, welche auf
stark vereinfachten physikalischen Regeln
basiert. Zugrunde liegt die Idee, die jewei-
ligen Oberfldchen mit Informationen Uber
Materialeigenschaften zu versehen. Diese
wiederum flieBen in die physikalische Be-
rechnung der Lichtbrechung und -reflexion
auf der Oberfldche ein.

Abb. 4: Flachen missen nicht als Vektorgrafiken erstellt, sondern kénnen
auch direkt in das Mesh gecuttet werden.
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Abb. 6: Fur die Verwendung
von Transparenzen muss die
Opacity Map im Alphakanal

der Albedo Map gespeichert

werden.
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Hierzu werden fol-
gende Texture Maps
bendtigt: Albedo
(oder Base Color, auch bekannt als Diffuse
Map) zur Farbgebung, Metalness fur den
Grad der Reflexion und Roughness fur die
Oberfldchenstruktur (weiche Materialien,
wie zum Beispiel Gummi, haben ande-
re Lichtbrechungseigenschaften wie harte
Oberfldchen). Metalness und Roughness
Maps lassen sich auch als Nachfolger der
Specular Map verstehen. Da es sich bei PBR
nicht um ein festgelegtes Regelwerk han-
delt, gibt es in der Praxis Rendermodelle,

Glanzeigenschaften einer Oberfldche die
tatsdchlichen Materialeigenschaften vorge-
geben werden. Da die Glanzreflexionen nun
nicht mehr fest definiert sind, lassen sie sich
im Rahmen von PBR auf Basis der physika-
lischen Attribute einer Oberfldche in Echtzeit
berechnen und addquat darstellen.

Texturing in Photoshop

FUr die Erstellung der Texture Maps 6ffnen
wir zundchst ein neues Photoshop-Doku-
ment. Hier bekommt jede Texture Map ihren
eignen Ordner (Abb. 5). Weitere mogliche
Texture Maps sind: Emissive fur Glow-Ef-
fekte, Opacity for Transparenz und Normal
Maps fur die Simulation von geometrischen
Oberfldchenstrukturen - hierzu spater mehr.

Zusammen mit der zuvor gerenderten
Color Map und dem Magic Wand Tool in
Photoshop kénnen wir nun zUgig Masken
erstellen und Grauwerte fur die einzelnen
Materialien in unserer Roughness und Me-
talness Map festlegen.

What you see is what you get

FUr die Feineinstellung der jeweiligen PBR-
Werte nehmen wir uns Marmoset Toolbag 2
zur Hilfe. Hierbei handelt es sich um ein
schlankes Tool zur PBR-Echtzeitberechnung
von 3D-Modellen. Besonders angenehm ist
die einfache Bedienung. Im Gegensatz zu
vollwertigen Game Engines mussen keine
Szenen erstellt werden - Umgebungen und
Lichteinstellungen sind vordefiniert und ein-
fach auszuwahlen. FUr individuelle Anpas-
sungen kénnen auch eigene Setups erstellt
werden. Meshes und Texture Maps lassen

sich einfach per Drag-

ele)

and-drop hinzufugen und
Objekte in Echtzeit im 3D-
Raum betrachten.

Marmoset Toolbag 2
Workflow

Durch die Kombination

Abb. 8: Vektorform in Photoshop, Normal Map und Echtzeitrender

die mit im Labor gemessenen Werten der
Oberfladchenbeschaffenheit arbeiten, sowie
Renderer, welche auf geschétzten Anndhe-
rungswerten basieren. Eine gute Ubersicht
Uber entsprechende Werte hat Sébastien
Lagarde auf seiner Seite zusammengestellt:
tinyurl.com/nvys3cs.

Bei klassischen Diffuse- und Specu-
lar- respektive Glossiness-Rendermodellen
mussten die Grauwerte in den Texture Maps
oft noch fur spezifische Beleuchtungssitu-
ationen von Hand angepasst werden. Dies
entfallt bei Physically Based Rendering, da
anstelle des Definierens von Werten fUr die

von Photoshop und Mar-
moset Toolbag 2 in unserem Arbeitsablauf
erhalten wir zwei Vorzioge auf einmal: Die
umfassende Funktionalitdt und Flexibilitat
von Photoshop und die Mdéglichkeit, unsere
Texturen in PBR und Echtzeit zu sehen. Hier-
zU genUgt ein einfacher Programmwechsel
mit Alt+Tab nach dem jeweiligen Speichern
einer Textur. Marmoset Toolbag 2 13dt ver-
3nderte Dateien, nachdem sie gespeichert
wurden, automatisch neu.

Um eine neue Szene einzurichten, zie-
hen wir als Erstes unsere zuvor exportierte
*.obj-Datei in den Viewport. Klicken wir nun
auf ,Sky" im Scenebrowser, kénnen wir
unter ,Presets" diverse Lichtstimmungen
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laden. Falls auf das Hintergrundbild
verzichtet werden soll, stellen wir den
Backdrop Mode von ,Sky" auf ,Color"
respektive ,Ambient Sky" fUr einen
Gradient im Hintergrund. Texturen
werden geladen, indem man erst auf
das Default Material und dann auf das
leere Fenster im entsprechenden Tex-
ture Slot klickt. Die Einstellungen fur
unser Material sind in Abb. 6 zu sehen.

Geometrische Details
zeichnen statt modellieren

Eine in der Videospielgrafik beliebte
Methode, um Performance zu spa-
ren, sind sogenannte Normal Maps.
FUr das Sparen von Rechenleistung
werden geometrische Feinheiten be-
wusst nicht modelliert, um somit we-
niger Details im Mesh berechnen zu muUssen.
Stattdessen wird eine zusatzliche Textur ver-
wendet. Hier werden Informationen Uber die
Abweichung von der Oberfldche des Meshs
per Pixel gespeichert (siehe Abb. 7). Ver-
einfacht beschrieben steht jeder Farbton in
der Normal Map fUr eine bestimmte Winkel-
gradzahl, um die Differenz zu der Normalen
des darunterliegenden Face zu beschreiben.

Ein gdngiger Workflow beim Erstellen von
Normal Maps ist das Projizieren von Highpoly
Meshes auf Modelle mit einem niedrigeren
Detailgrad (Baking). Dieser Prozess ist ver-
gleichbar mit dem beschriebenen Verfahren,
Farbinformationen aus dem Shader in eine
Textur zu rendern - nur handelt es sich hier
nicht um Farb-, sondern eben um Geome-
trieinformationen.

Eine weitere Mdglichkeit Normal Maps
zu erstellen, besteht darin, aus Graustufen-
bildern Hoheninformationen abzuleiten und
diese in Normalinformationen zu konver-
tieren. Praktisch bedeutet dies, dass Ver-
tiefungen gegen Schwarz und Erhéhungen
gegen WeiB eingezeichnet und im nachsten
Schritt per Algorithmus in Normalinformati-
on umgewandelt werden. In Photoshop be-
findet sich diese Funktionalitat unter: Filter >
3D > Generate Normal Map ... (vgl. Abb. 8).

Benutzer alterer Photoshopversionen
kénnen sich ein kostenloses Plug-in von
der Nvidia-Developer-Seite herunterladen:
tinyurl.com/paz97yz.
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Finaler Render

Marmoset Toolbag 2 enthadlt alle auch in
geldufigen Game Engines gangigen Einstel-
lungen wie zum Beispiel Color Correction
oder Depth of Field (siehe Abb. 9). Zusatz-
lich verfogt das Tool Uber die Mdglichkeit
der stereoskopischen Darstellung, unter an-
derem mit dem VR Headset Oculus Rift DK1
(Render > Stereo 3D > Stereo Mode).

Des Weiteren bietet das Programm die
Maglichkeit, eine Szene zur Darstellung auf
einer Webseite zu exportieren. Dabei wird
eine .mview-Datei erstellt (File > Viewer
Export ...), welche ohne weitere bendtigte
Browser-Plug-ins direkt in HTML5 eingebun-
den werden kann:

<head>

<script src=*https://viewer.marmoset.co/
main/marmoset.js‘“></script>

</head»

<body>

<scripty

marmoset.embed( ,scene.mview®, { width
800, height: 600, autoStart: true, full-
Frame: false, pagePreset: false } );
</script>

</body>

Breite und Hohe des eingebetteten View-
ports werden mit den Werten ,Width" und
,Height" definiert. Es gilt zu beachten, dass
eine Vorschau im Browser nicht mit lokalen
Quelldateien, sondern nur von einem Web-
server aus funktioniert.

ot

Abb. 9: Gangige Einstellungen
wie Color Correction, DOF und

stereoskopische Darstellung
sind bereits enthalten.

Fazit

Der beschriebene Workflow ermoglicht nicht
nur die qualitativ hochwertige Darstellung
in Echtzeit, sondern auch, Anderungen im
Modell und in der Textur sofort sichtbar zu
machen. Es entstehen keine Wartezeiten
durch aufwendige Renderprozesse. So wer-
den Kosten- und Zeitaufwand bei lterati-
onen minimiert. Die Darstellung ist nicht auf
Standbilder beschrankt. Gegenstande lassen
sich von allen Seiten in beliebigen Beleuch-
tungssituationen betrachten.

Zusatzlich bietet unser Projektaufbau
die Grundlage fUr den weiteren Gebrauch
in qualitativ und technologisch ausgereif-
ten Echtzeitumgebungen wie der Unreal
Engine.

Animationen wie Kamerafahrten oder
Turntables sowie Simulationen, wie Time
of Day fUr zum Beispiel Architekturvisua-
lisierung oder auch Wettereffekte, kdnnen
hier schnell und effektiv realisiert werden.
Custom Interfaces fur interaktive Produkt-
demos sind ebenfalls denkbar. >ei

Patrick Mochel ist Head Instructor for
den Bereich Game Art am SAE Institute
Hamburg. Zuvor arbeitete er als
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